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Introduction 

Technical Support 

 Thank you for purchasing the SLC-M series. This product is warranted to be free of 

manufacturing defects for one year from the date of purchase. Our technical support 

group is glad to work with you in answering your questions. If you cannot find the 

solution to your particular application, or, if for any reason you need additional 

technical assistance, please use the ways as following: 

 

Tel: 886-3-5727772 (Mon.-Fri., 8:30 - 18:00, Taiwan) 

Fax: 886-3-5728898 

Email: service@lttcorp.com 

Web: www.lttcorp.com 

Address: No. 121, Lane 99, Pu-Ding Road, Hsin Chu City, Taiwan, R.O.C. 

Disclaimer 

 The information provided in this document is believed to be reliable. However, no 

responsibility is assumed for any possible inaccuracies or omissions. Specifications 

are subject to change without notice. The Windows 2000/XP/Vista are registered 

trademarks of Microsoft. Other trademarks are the property of their respective 

owners. 

 

LTT reserves the right to make changes without further notice to any products herein 

to improve reliability, function, or design. LTT does not assume any liability arising out 

of the application or use of any product or circuit described herein; neither does it 

convey any license under its patent rights, nor the rights of others. 

Special Symbols 

 

Failure to follow instructions may lead to product damage, or error. 

 

Failure to follow instructions may lead to injury by electric shock. 

 

Failure to follow instructions may lead to injury by invisible radiation. 
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Chapter 1  Safety 

1.1  Safety Regulation 

 

 

 

The SLC-M series uses a CO2 Laser as a light source. It is classified as a class-IIIR 

product by CDRH (the Center for Devices and Radiological Health). 

 

Wavelength : 9.3~10.6μm 

Maximum output power : 30 ~ 100W 

Visibility : Invisible 

 

When operating the SLC-M series, be sure to always comply 
with the safety regulations as following: 
 
 Do not attempt to modify or disassemble any component of the machine without 

LTT technical support. 

 Do not open the doors of chassis and access the laser tube or electronic 

components, especially while the machine power is on. 

 Connect the machine to a grounded outlet. Verify that the voltage of the outlet 

is correct for the machine. 

 Do not disable the interlocks which are on top and front doors. 

 Be careful about the path of the invisible laser beam shown in figure. Otherwise, 

eye or skin injury may result. 
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 Do not watch the laser beam directly during operation. Bright light caused by 

the lasing process can damage the eye. 

 The side and rear doors are fixed by screws for safety. If you open these doors, 

the SLC-M will become a Class 4 laser device. For your safe, please wear 

protective goggles. 

 The laser beam may cause fire. Never leave machine along without other 

operator watching during the laser cutting process. Keep a fire extinguisher near 

the machine at any time. 

 Blowing materials with air flow from nozzle while cutting or engraving can avoid 

fire occurring and also obtain good quality. 

 Verify that materials used in the cutting are proper for lasing. Never cut 

substrates that contain PVC or Teflon. 

 Good efficiency of exhaust system makes you avoid breathing dust, debris or 

poison gas. 

 Please comply with maintenance schedule as chapter 4 to keep SLC-M working 

well. 

 Before you execute auto focusing function, please make sure that there will be 

no crashing between motion system and other objects. For safety, it is NOT 

recommended to use auto focusing function on inequality materials. 
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1.2  Name Plate and Warning Labels 

 The labels as following are affixed to the SLC-M. These labels must never be 

removed. If they are damaged or tampered for any reason, please request for LTT 

immediately to replace them. 

 

 

1 

4 

2 

3 

2 

4 

2 
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1  

2 

 

 

 
Laser Tools & Technics Corporation 

 Model No: SLC-M-C60M Serial No: 9810000 

 Specification: V60, 220~240V, 15A 

 Manufacture Date: 2008 .12  
N o .  1 2 1 ,  L a n e  9 9 ,  P U - D I N G  R O AD ,  

H S I N  C H U  C I T Y,  TAI WAN ,  R . O . C .  

T E L  :  8 8 6 - 3 - 5 7 2 7 7 7 2  

FAX  :  8 8 6 - 3 - 5 7 2 8 8 9 8  

5 
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1.3  Safety Protection Device  

  Interlock 
The laser beam will not be emitted if you open the front door. The LED indicator of 

“DOOR” on control panel will be off. 

 

  
Front door close 

   
Front door opens 

 Laser Switch 
Laser switch on control panel can shut down the power of laser system immediately, 

and it has no effect on motion system. Compared with interlock, Turning off laser 

switch can save power. When you turn on laser switch, the LED indicator of “LASER” 

on control panel will be on (it needs to take more than 5 seconds to warm up laser 

tube while you turn it on). 

 ON 

 

 OFF 
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 Emergency Stop Switch 
Pressing the red pushbutton can shut down the main power of system immediately 

when emergency condition occurs. And turning right the red pushbutton can recover 

the power (Before recovering power, please clear the trouble in the machine first). 

 ON 
 

 OFF 
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Chapter 2  Installation

2.1  Unpack and Locate Machine 

 This section explains how to unpack and locate machine. 

1. Locate the machine and keep the recommended space for maintenance. 

2. Lock the wheels to locate the machine. 
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2.2  Package Contents List 
 This section explains the package contents of the SLC. The package includes the 

following components. Before using the unit, check that all components have been 

included in the package. 

 

 

 

1 Box 5 LaserCAM Driver CD-Rom 

2 Cotton Swab 6 USB Cable Driver CD-Rom 

3 Alcohol Dropper 7 USB Cable 

4 Allen Wrench 8 Power Cable 

 Package contents for CCD connection (available for CCD option selected) 

1. RS232 cable  

 

8 

7 
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3 

2 
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2. RS232 to USB transformer 

 

3. RJ45 cable 

 

 

2.3  Part Names and Functions 
 This section explains the main part names and functions of the SLC-M. 

 

 

  

1. Front Door                                                        

1 

2 

3 
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This door has interlock sensors for safety. If you open this door, the laser will be not 

emitted. 

 

2. Front Door of chassis 
Mostly opening this door is for maintaining. Do NOT open this door if it’s not 

necessary, especially the machine power is on. 

 

3. Side Door (Right) of chassis 
Mostly opening this door is for maintaining. Do NOT open this door if it’s not 

necessary, especially the machine power is on. 

  

4. Exhaust Port  
These two ports can exhaust the smoke which is caused by cutting. These ports have 

to be connected to blower through pipes. 

 

5. Rear Door of chassis 

Mostly opening this door is for maintaining. Do NOT open this door if it’s not 

necessary, especially the machine power is on. 

 6. Air Filter 
This part provides air assist through the hose which is connected to air compressor. 

 7. Fans 
These parts can dissipate the heat in the chassis which is caused by laser generator. 

8. Side Door (Left) of chassis 

5 

6 

8 

4 

7 
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Mostly opening this door is for maintaining. Do NOT open this door if it’s not 

necessary, especially the machine power is on. 

 

 

9. Window Lens 
This part can protect 1st ~3rd mirror against dusts or debris. It should be cleaned this 

lens daily. (See chapter 4) 

10. 4th Mirror 
This part reflects laser beam to carriage. Also, it should be cleaned this lens daily. 

(See chapter 4) 

11. Table  
This part can carry materials for cutting. 

12. Carriage 
This part includes 5th mirror, focal lens, nozzle, and auto focusing set. You can move 

it left, right, forth and back by the keys on control panel. (See section 3.2.1) 

10 

11 

9 

12 
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13. 5th Mirror 
This part reflect laser beam to focal lens. Also, it should be cleaned daily. (See 

chapter 4) 

14. Focal Lens 
This part can focus the laser beam on materials for cutiing. Also, it should be cleaned 

this lens daily. (See chapter 4) 

15. Auto Focal Pin 
This part can adjust focal height automatically by touching material. 

 

16. Air Assist Adjustment 
This part can adjust air flow which is out of the nozzle. 

17. Nozzle 
This part can provide a air assist to protect focal lens against dust or debris. 

18. Real-time Exhaust 
This part can remove dust immediately 

 

 

13 

14 
16 

15 
17 

18 
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19. Emergency Stop 
Please see section 1.3 

20. Power Switch 
This switch can turn on/off the main power of this machine. 

 ON 

 

 OFF 

 

21. Laser Switch 
Please see section 1.3 

22. LCD Display 
LCD display shows the operating menu and information from system. If you want to 

obtain more detail about operating menu, please see section 3.2.2. 

23. Control Panel 
Control panel provide the keys to operate machine. If you want to obtain more detail 

about operating menu, please see section 3.2.1. 

20 19 

21 

22 

23 
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24. Electromagnetic Valve Port 
This part is used for part electromagnetic valve. 

25. Air Inlet Port 
This part is the total air inlet for this machine. 

26. USB Port 
This part can send files from computer to machine through a USB cable. 

27. Serials Port 

This part is used for the expansion of I/O module. 

28. Electromagnetic Valve 
This part is used for air flow steady before cutting  

29. Power Inlet 

This part can provide main power through cable from power supply. 

 

 

24 

26 
29 

25 

27 

28 



Chapter 2   Installation 

 19 

 

2.4  Hardware Installation 

 

 

 
 

This section explains the installation steps with other hardware. 

1. Check environment 
 Power supply 

Power supply : 220 VAC 

 Environment 

Temperature: 0 ~ 30 ℃, No freezing 

Relative humidity : 35 ~ 85 % 

Other : Avoid to dust, dirt, oil, mist, strong vibration, or sudden temperature changes 

 

2. Connect AC power cable 

 

3. Connect USB cable from computer to machine 
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4. Connect pipes from exhaust port to blower 

 

5. Connect hose from air filter to compressor 
 

 

6. Connect RS232 cable from PC to machine 
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7. Connect RJ45 cable from PC to machine (There is another connection wa
You can connect PC to local network area, and connect machine to the sam
network area) 
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2.5  Driver Installation 

2.5.1  Install Driver 

` This section explains the installation steps for driver on computer. 

 

1. Check computer equipment 
A High speed computer will calculate image file quicker and take less time to send 

files to machine.  

 Minimum  Recommended  

 Pentium 133MHz CPU 

 64 MB RAM 

 2 GB Hard Disk 

 Microsoft Windows 2000 

 8MB Graphics Card 

 CD-ROM Drive 

 VGA monitor (800X600) 

 CorelDraw 10 

or AutoCAD R14 

 Pentium-4 2.2GHz CPU 

 512 MB RAM 

 5 GB Hard Disk 

 Microsoft Windows XP 

 64MB Graphics Card 

 DVD-ROM Drive 

 VGA monitor (1024X768) 

 CorelDraw X3 

or AutoCAD 2008 

2. Put the CD-ROM of installation into CD/DVD drive 

3. Go to the [Printers and Faxes] window and select the [Add a 
printer] option 
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4. Click the [Next] button 

 

5. Select [Local printer attached to this computer], uncheck 
[Automatically detect and install my Plug and Play printer], 
then click the [Next] button 
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6. Select [Use the following port] and [USB00*], click the 
[Next] button. (The * is depended on the USB port that is 
connected with SLC-M) 

 

7. Click [Have Disk...] 
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8. Click [Browse…] button 

 

9. Select the inf file 
Browse to the location of inf file. If it is on a CD-ROM, please browse to the CD-ROM. 

Select the *.inf file which matches with your machine type. 

 

10. Click [OK] button 
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 11. Click [Next] button 

 

 

If the [Use Existing Driver] box shows, select [Replace existing driver] and 

click [Next] button. 
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12. Click [Next] button 

 

If you want this machine to be the default printer, then please select [Yes], or please 

select [No]. If there are no other drivers installed on your computer, the SLC-M will 

automatically be set as your default printer. 

 

13. Select [Do not share this printer], and click [Next] 
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14. Select [No], and click [Next] 

 

15. Click [Finish] button 
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When the [Hardware Installation] box shows, please click [Continue Anyway]. 

Then your new driver installation is complete. 

 

16. Close [Printers and Faxes] window 
If your driver is now listed on the [Printers and Faxes] window, the installation was 

successful. Then you can close the window. 
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2.5.2  Uninstall Driver  

 1 Go to the [Printers and Faxes] window 

2 Select the Printer you want to delete and then press the 
[Delete this Printer] button. 

 

 
3 Press the [Yes] button and reboot computer. 
 

 

4 Press right key of mouse on the [Printers and Faxes] 
window. Select the [Server Properties…] option. 
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5 Switch to [Drivers] tab and choose the Printer you have 
just deleted. Press [Remove] button. 

 

 

6 Press [Yes] button. 
 

 

7 Press [Close] button. 
 

 

8 Close the [Printers and Faxes] window. 
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2.5.3  Change USB Cable to Another Port 

 This section explains that the steps when change USB port. 

 

Once you contact the USB Cable to computer, we strongly suggest that do not 

change it to another USB port. If you must change USB cable to another port, you 

have to also change the printer settings of SLC-M. If this happens, please follow 

next steps. 

 1.  Connect the USB cable to another port well with SLC-M. 

2.  Open [Printer and Faxes] window 

 

3.  Right click SLC-M ter and select [Properties] 
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4.  Switch to [Ports] label. Switch the [USB00*] which is belong to the new port 

and click [OK]. 

 

5.  Done. 
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2.6  CorelDRAW Setup 

 It is strongly recommended to keep the graphic software’s page size the same with 

driver’s page size before you begin editing files. Here you will learn how to setup your 

page and learn how to keep those settings that you don’t have to setup again next 

time. If you are a autocad user, please see section 2.7. 

Go to [Layout] → [Page Setup] 

 

Modify [Width] and [Height] according to work area (See Appendix 1). Click 

[Save Custom Page] button. 

 

Name this paper type. It is recommended to name with the machine type. Then 

click [OK] to save. 
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Click [OK] to complete the paper size adjustment. 

 

 Next time you can select template style while you create new file. 

 

 



Chapter 2   Installation 

 36 

 

2.7  AutoCad Setup 

 Here you will learn how to setup the page and print setting on AutoCAD. 

1.  Page And Layout Setup 

Open the AutoCAD. Type [limits] on the command line then press [Enter] key. 

 

Then press [Enter] key to set the bottom left corner to [0,0]. 

 

Setting the top right corner according to work area (See Appendix 1). Then 

press [Enter] key. 

 

Turn on the grid by typing [grid] on the command line or turn on directly by 

pressing the [GRID] button which located under the command line. The grid 

shows the page area so that can help user to see boundary. 
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Choose [File] → [Save as]. Then select [Files of type] as [*.dwt]. Set file 

name as machine type and then press [Save] button to save the Template 

style. 

 

Write down some description for the template and set the measurement unit 

system you want. 

 

You can select the template file you created whenever open AutoCAD. Next 

time when you use the same page size, you can use the template file directly 

so that you don’t have to setup the page anymore. 
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2.  Print Setting 

Go to [File] → [Plot]. When the [Plot] window shows, select printer driver 

and click [Properties] button. 

 

Select [Modify Standard Paper Sizes] on the tree-list box. Select the 

option which starts with [LTT…]. Press [Modify] button. 
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Modify [Top], [Down], [Left] and [Right] to zero, press [Next] button to 

continue. 

 

Press [Next] button to continue. 

 

Press [Finish] button to continue. 
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Select [Custom Properties] and click [Custom Properties] button at 

middle. 

 

Modify Laser settings if need. Press [OK] to finish driver setting. 
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Press [OK] to back to print setting. 

 

Select [Save changes to the following file] and press [OK] to continue. 
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You will find the printer option that you just created (*.pc3) on [Name] box. 

Please select the new printer instead of original in the future. 

 

Select [Plot style table] to acad.ctb. Press [Edit] button. 

 

Press [Yes] button to continue. 
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Use [Shift] key to help selecting all colors in [Plot styles] list. Set the 

[Linetype] to [solid] and the [Lineweight] to [0.0000 mm] Press [Save 

& close] button to continue. 

 

 Please follow the settings below. Switch to [Plot Settings] tab. Select the 

[Plot scale] to [1:1]. Select the [Plot area] to [Limits]. The [Drawing 

orientation] should be set to [Landscape]. Then Press [OK] to send file to 

machine. 
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2.8  LTT Product Tools 

2.8.1  Install Procedure 

 LTT Product Tools is the software which can send prn or plt file, update firmware, and 

change the Ethernet settings. This section explains the installation steps on your 

computer. 

1.  Double click [setup.exe], (the file is included in the installation CD) 
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2.  When you see the diagram below, please press the [Accept] key to go on. If not, 

please go to Step 4. 

 

3. When you see the diagram below, please wait for some minutes. 

 

4. When you see the diagram below, please press the [Next] key to go on. 
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5. When you see the diagram below, please choose a position to install the software, 

or use the default value. And press [Next] key to go on. 
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6.  Press [Next] key to go on. 

 

7.  Press [Close] key to finish the setup procedure. 

 

8.  After the setup procedure, you can open the software from two shortcuts. The 

first one locates on the [Desktop], and the second one is placed in the [Start 

Manu]. 
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2.8.2  Uninstall Procedure 
 1.  Click [Start] [Settings]  [Control Panel] 

 

2.  Double click [Add or Remove Programs] 

 

3.  Click [LTT Product Tools]  Press [Remove] key 
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4.  Please choose [Yes] 

 

5. Done 

 

 

2.9  AutoCCD 

2.9.1  Install Procedure 
 AutoCCD is the main control program for cutting with CCD camera. This section explains the installation step

1. Before using AutoCCD, it needs to install the CCD control program – [In-sign explore]. (Please use th

version may cause unknown problem.) 

 

2. Please copy the file [InSightSoftware411.exe] to your PC, and double click it. (the file is included in

 

3. click [Install] to proceed. 

 

4. After the extracting procedure, you can find the file [Setup.hta] in the same folder with [Insightsoftwa

5.  Click [in–Sight Software 4.1.1 (Not Installed)] to go on.  
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6. Click [Install Now] button to go on. 

 

 

 

 

7. When you see the below diagram, click [next]. 
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8. choose [I accept the terms in the license agreement], and click [next] 

 

 

 

 

9.  Click [Next] to go on 
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10. Click [Next] to go on 

 

 

 

 

11.  Click [Install] to go on 
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12. Waiting for install procedure. When seeing blow window. Click [Finish] to finish install procedure for [In

 

13.  After install the [In-Sight Explorer], copy the file [AutoCCD.EXE] from install CD. You can double th

 

2.9.2  Uninstall Procedure 
 1.  Click [Start] [Settings]  [Control Panel] 
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2.  Double click [Add or Remove Programs] 

 
 

3. Click [Cognex In-Sight Software 4.1.1]  Press [Remove] key 

 

 

 

4.  Please choose [Yes] 
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5. Delete the file [AutoCCD.EXE] 
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Chapter 3  Operation 

3.1  Operator Position 

 This section shows the position when you operate machine. 

 

3.2  Basic Operation Flow without CCD 
 This section explains the basic and common steps to operate SLC-M. If you want to 

obtain more detail about operation, please see section 3.3 and 3.4. 

  

Before process the steps in this section, please make sure that you have already 

finished all steps in chapter 2. 

1. Get machine ready. 
 Turn on the power. 

 Wait for system start and homing process finishing. 

2. Send file to machine. 
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 Open a drawing file or draw a new one on CorelDraw or AutoCAD. 

 Execute the [Print] or [Plot] function. 

 Modify the settings of driver. (See section 3.4) 

 Click [OK] to send file. 

3. Adjust focal height (if necessary). 
 Put the material on the table. 

 Move the carriage above the material. 

 Press     and select [Yes]. 

4. Execute file. 
 Select the file on control panel. 

 Make sure all LED indicators on control panel are on. (If not, see chapter 5) 

 Press     to start file. 

 

3.3  Machine Operation without CCD 
 This section explains the detail about how to operate SLC-M. 
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3.3.1  Control Panel 
  

 

1. Cursor Up / Increase Values 

2. Escape 

3. Cursor Down / Decrease Values 

4. Enter 

5. Previous File 

6. Next File 

7. Stop 

8. Run / Pause 

9. Move to P1 

10. Move to P2 

11. Red Beam Switch/ Lase 

12. Move Carriage Left (X-) 

13. Move Carriage Right (X+) 

14. Move Carriage Forward (Y-) 

15. Move Carriage Back (Y+) 

16. Homing 

17. Ready Indicator 

18. Laser Indicator 

19. Door Indicator 

20. Focal Lens Up 

21. Auto Focusing 

22. Focal Lens Down 

1. Cursor Up / Increase Values 
Move the cursor up or increase values. 

2. Escape 

2 

1 3 

4 

7 

8 

6 

5 

9 

10 

11 

17 

18 

19 

14 

16 

13 

15 

20 

21 

22 

12 
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Escape from sub-menu or sub-selection 

3. Cursor Down / Decrease Values 
Move the cursor down or decrease values. 

4. Enter 
Enter into sub-menu or confirm the selection. 

5. Previous 
Select previous file in file list. 

6. Next 
Select next file in file list. 

7. Stop 
Give up the file that is in pause mode. You can’t stop file directly which is not in pause 

mode. 

8. Run / Pause 
Run the file when system is ready or in pause mode. Pause the file when it is running. 

9. Move Carriage to P1 
Move the carriage to the location of P1. The way to set location of P1, please see 

section 3.3.2 

10. Move Carriage to P2 
Move carriage to the location of P2. The way to set location of P2, please see section 

3.3.2 

11. Red Beam Switch / Lase 
 

 

Turn on/off the red beam normally.  

 

But if in the sub-menu of [Alignment mode] (See section 3.3.2), this key will turn 

to emit the laser beam for alignment. 

12. Move Carriage Left (X-) 
Move the carriage left slowly when press this key shortly. If you want to move the 

carriage left faster, please press and hold this key. 

13. Move Carriage Right (X+) 
Move the carriage right slowly when press this key shortly. If you want to move the 

carriage right faster, please press and hold this key. 

14. Move Carriage Forward (Y-) 
Move the carriage forward slowly when press this key shortly. If you want to move 

the carriage forward faster, please press and hold this key. 
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15. Move Carriage Back (Y+) 
Move the carriage back slowly when press this key shortly. If you want to move the 

carriage back faster, please press and hold this key. 

16. Homing 
Move the carriage to home and reset the position of home if the carriage loses its 

position. 

 

After the homing process, you have to press     so that you can leave the homing 

page. 

17. Ready Indicator 
This indicator will be on when system is ready to run file and no file is in pause mode. 

18. Laser Indicator 
This indicator will be on when laser tube is ready for emission. 

19. Door Indicator 
This indicator will be on when all doors with interlocks are closed. 

20. Focal Lens Up 
Move the focal lens up slowly when press this key shortly. If you want to move the 

focal lens up faster, please press and hold this key. 

21. Auto Focusing 
Automatically adjust the distance of lens and material to focus length. 

22. Focal lens Down 
Move the focal lens down slowly when press this key shortly. If you want to move the 

table down faster, please press and hold this key. 
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3.3.2  Operating Menu 

 1. Work Display 

 

 1 /11* 

Indicates that there are totally 11 files in memory, and the first file is selected at 

present. You can press     and     to select files. 

 PICTURE-2 :  

Indicates that the present file is named “PICTURE-2”. You can name file on the 

tab “Page” of driver. (See section 3.4.3) 

 QTY  2/5 :  

Indicates that the file is limited to be executed 5 times at most, and system has 

finished 2 times. It will be invalid to press      if system has finished 5 times. 

The way to modify this setting is described in section 3.4.3. 

 COPY 3 : 

Indicates that the file will repeat 3 times automatically if you press     one 

time. The way to modify this setting is described in section 3.4.3. 

 Time  0:29 /  0:00 

The first timer records the pass time at present when a file is executed. The 

second timer will record the total time if the file has ever finished at one time 

 Free  63.15 MB  dpi 0 

If no file is executed, this line will display available memory. If a file is being 

executed, it will display the current power and speed settings. 

■1. WORK DISPLAY 
2. FILE MANAGER 
3. LASER PARAMETER
4. SYSTEM SETUP 

1/11*      PICTURE-2 
■QTY   2/5   COPY 3 

Time   0:29 /    0:00 
Free  63.15MB  dpi 0

■1/11*      PICTURE-2 
QTY   2/5   COPY 3 
Time   0:29 /    0:00 
Free  63.15MB  dpi 0
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 2. FILE MANAGER 

 

 1 /11*    PICTURE-2 

Like the definition in Work display, it indicates the number and name of files. You 

can press     and     to select files. 

 Del. the file :  

This selection can delete single file which is selected at present. 

 Delete all files : 

This selection can delete all files in memory. 

 Net Status 

This selection can show the settings of Ethernet. 

1. WORK DISPLAY 
■2. FILE MANAGER 

3. LASER PARAMETER
4. SYSTEM SETUP 

1/11*      PICTURE-2 
■Del. the file      134B 

Delete all files 
Net Status

You Sure? 
■Yes 

No 

You Sure? 
■Yes 

No 

1/11*      PICTURE-2 
Del. the file      134B 

■Delete all files 
Net Status

■1/11*      PICTURE-2 
Del. the file      134B 
Delete all files 
Net Status

1/11*      PICTURE-2 
Del. the file      134B 
Delete all files 

■Net Status

Computer Name/Shared 
=LTTWORK/TMP 
Local Machine ID 
=LAS4B-0001 
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 3. Laser Parameter 

 

1. WORK DISPLAY 
2. FILE MANAGER 

■3. LASER PARAMETER
4. SYSTEM SETUP 

Color setup 
■Color control 

Laser tickle setup 
Alignment mode 

Color Control 
by file 
 
 

Laser tickle setup 
■Rate           5 khz 

Idle width             1 usec 
Live width         1 usec 

Color setup 
Color control 

■Laser tickle setup 
Alignment mode 

■Color setup 
Color control 
Laser tickle setup 
Alignment mode 

Color setup 
Color control 
Laser tickle setup 

■Alignment mode 

■Setting Pen    1 Blac 
Power          50% 
Speed         100% 
PPI            1000 

Alignment mode 
■Tickle output      1% 

Continuous        off 
Fast move         off 
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 Color Setup 

     The settings of each color can be adjusted under this selection after the file has 

been sent. It is not necessary to use because mostly all settings are defined in 

print driver before sending the file. 

 Setting Pen 

Indicates the color you want to modify. 

 Power 

     Indicates the present power for setting pen. Its range is between 0~100%. 

 Speed 

     Indicates the present speed for setting pen. Its range is between 0~100%. 

 PPI 

     Indicates the number of pulses per inch for setting pen. It has six options, 

and they are 166, 200, 250, 333, 500, and 1000. 

 Color Control 

There are two options: [by file] and [by panel]. [by file] means that the color 

settings are defined based on print driver for single file. [by panel] means that 

the color settings are defined based on [Color Setup] for all files. 

 

 Laser Tickle Setup 

The laser tickle pre-ionizes the gas into a plasma state so that it is just below the 

lase threshold. Increasing tickle width beyond 1 μs will add enough energy to 

the plasma to cause laser emission. By applying a laser tickle, the laser will 

respond predictably to laser signal even when there is considerable “off” time 

between applied pulses. It is recommended NOT to change the settings unless 

instructed to by a LTT technician. 

 

 Alignment Mode 

This function is used for alignment of laser. It is recommended NOT to use this 

function unless instructed to by a LTT technician. 

 Tickle output 

     Indicates the power for laser tickle. Its range is between 0~100%. 

 Continuous 

If this function is on and press     , the laser tickle will emit continuously 

until pressing     again. If this function is off, the laser tickle emits only 

when you keep pressing     . 

 Fast move 

     If this function is on, you can move the carriage faster to nine position of 

working table by using motion control keys. 
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 4. System Setup 

 

1. WORK DISPLAY 
2. FILE MANAGER 
3. LASER PARAMETER

■4. SYSTEM SETUP 

Configuration 
■Position setup 

Status 
About SLC-M-C60M 

■Adjust X-Y axis 
Focus Length 
Auto Focusing 
X-Y homing 

■Configuration 
Position setup 
Status 
About SLC-M-C60M 

■Rule unit:        step 
Sleep mode:   10 min 
Auto run:          off 
Arc comp:         off 

X loc.     600.000mm 
  Y loc.     500.000mm 
■Set as P1 

Set as P2 

Adjust X-Y axis 
■Focus Length 

Auto Focusing 
X-Y homing

Adjust X-Y axis 
Focus Length 

■Auto Focusing 
X-Y homing

Focus = 1.500 inch 
 
 
 

You Sure? 
■Yes 

No 

You Sure? 
■Yes 

No 

Adjust X-Y axis 
Focus Length 
Auto Focusing 

■X-Y homing 
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 Configuration 

 Rule unit 

This function can allow user to select the unit of length for system. There 

are three options: step, millimeter, and inch. 

 Sleep mode 

After the setting time, system will turn off the power of laser tube if there 

is still no file being executed. 

 Auto run 

     This item has been deactivated. 

 Arc comp 

          Compensates laser output power while cutting an arc. 

 Position setup 

 Adjust X-Y axis 

     This function can allow user to set the position of [P1] and [P2]. Please 

move the carriage to the position that you want set for [P1] or [P2]. Then 

press [Enter] when the cursor is on the right side of [Set as P1] or [Set 

as P2]. 

 Focus Length 

This function can change focal length for auto focusing if you change the 

size of focus lens. 

 Auto Focusing 

     Focusing the laser automatically. This function is the same with      . 

 X-Y homing 

Move the carriage to home, and reset the position of home if the carriage 

loses position. This function is the same with      . 

■X loc.     600.000mm 
  Y loc.     500.000mm 

Z loc.       0.000mm 
data is OK! 

Configuration 
Position setup 

■Status 
About SLC-M-C60M 

Configuration 
Position setup 
Status 

■About SLC-M-C60M 

Laser Tools & 
Technics Corp. 
SN:9810000 

2008/12/5 Ver 8.08 
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 Status 

This function can show the position of carriage and table. 

 About SLC-M #### 

     This function can show the firmware version and the machine serial number. 
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3.4  Print Driver Operation 

 Because SLC-M is controlled by a standard Windows printer driver, you can create 

the drawing on your favorite graphics software based on Windows system. When you 

want to send files to SLC-M, you can easy modify the driver settings just like using a 

desktop printer. There are four tabs in SLC-M driver programming: Laser, Job, 

Page, and Power scale.               

3.4.1  Laser Tab 
 The [Laser] tab contains Power, Speed, and PPI for eight colors. Other functions 

enable user to save and load configuration files of driver settings, check driver 

information, tune machine, and customize the language of driver. 

 

 1.  Color 
SLC-M system can cut with eight groups of power, speed and PPI according to 

the color in drawing. If the color in drawing does not belong any one of these eight 

colors, then driver will choose a similar one according to its RGB values. 
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2.  Power 
This item can control the output power by setting the percentage of maximum 

power. For example, if the maximum power of Laser generator is 30 Watts, then 

setting 50% power will generate about 15 Watts of output power. 

3.  Speed 
This item can control the output speed by setting the percentage of maximum 

speed. For example, if the maximum speed of cutting is 60 ips, then setting 

50% speed will produce about 30 ips of cutting speed. 

4.  PPI 
PPI means “Pulses Per Inch”. This item controls the numbers of laser pulses in 

one inch. This item only affects vector cutting. It is recommended to decrease 

PPI for dull materials like wood and increased for polished materials like acrylic. 

5.  Setup 
The settings of power, speed, and PPI can be modified by editing the text boxes 

and dragging the sliders. Then please click the setup button to save the new 

values for each setting. 

6.  Save 
Clicking this button will pop up a [Save Setup File] window. User can save all 

settings into a configuration file (*.lcf). 

 

7.  Load 
Clicking this button will pop up a [Load Setup File] window. User can load all 

settings from a configuration file (*.lcf). 
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9.  Language 
This drop-down box allows user to select different languages.  

10. Version 
Clicking this button will show the version of driver. 

11. Custom Lang. 
Clicking this button will pop up a [CUSTOM LANGUAGE] window that can 

allow user to modify or create custom language. 
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3.4.2  Job Tab 
 The Job tab is divided into four sections: Job Mode and Cut & Engrave Setup. 

 

1.  Job Mode 
     Normal 

This mode uses the eight color settings to vector cut graphics drawn in the 

graphic software. (other mode is not supply for SLC-M at this time) 

2. Advanced Mode 
     Mirror 

This mode will mirror the drawing horizontally. However, we suggest mirroring 

your drawing in the graphics program which will allow you to accurately preview 

the drawing before the job is sent to the machine. 

     Pulse Mode 

     This mode can be enabled for drilling holes. For details on holes drilling, contact 

technical support. 

     Vector Optimization 

This mode can modify the working path base on positions of vector in the 

drawing, it can decrease working time. 

Joint Curves 

This mode can make cutting circle or arc faster and smoother. 
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4
7

3. Cut & Engrave Setup 
     The Cut & Engrave Setup section allows the user to enable and disable certain 

functions of the machine. If the box next to Cut is unchecked the machine will 

disregard any potions of the graphics that instruct the laser to vector cut. 

engraving mode is not supply at this time. For more precise control the boxes 

below each color allow the user to disable the cut options independently for each 

color. 

     By Color 

When [By Color] is selected vector are cut according to the predefined color 

order. And vectors of the same color are cut in the sequence they have been 

drawn. 

     By Drawing 

When [By Drawing] is selected all vectors are cut in the sequence in which 

they have been drawn, regardless of color. 
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3.4.3  Page Tab 
 The Page Tab is divided into four sections: Page Setup, Job Title, Repetition, and 

Position Mode. 

 

1.  Page Setup 
The Page Setup section includes the Width and Height information of machine. 

There are two functions in this section. They are Imperial and Time Estimate. 

     Imperial 

Checking this box to switch the driver between the metric and imperial systems 

of measurement. 

     Time Estimate 

The Time Estimate function is apply in engraving function, it is not supply in 

SLC-M 

2.  Job Title 
The Job Title input box allows the user to input a title for the job being sent to 

the machine. The title entered will be the top line of the job file on the display of 

the machine. 

3.  Repetition 
The Repetition section allows the user to modify the setting of [Copy] and 

[Quantity] which will be shown on panel. (See section 3.2.2) 
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 4.  Position Mode 

     Temp Ref. Point 

     If this box is checked, the file will not execute in the position as application 

software. Otherwise, it will execute in the position where user determine on 

machine. 

Relative Point 

There are nine relative points. They are Top Left, Top Middle, Top Right, 

Middle Left, Center, Middle Right, Bottom Left, Bottom Middle and 

Bottom Right. Those points mean different positions on the boundary of 

drawing in application software. 

  

 

 

 

Top Left 

Top Middle 

Top Right 

Middle Left 

Center 

Middle Right 

Bottom Left 

Bottom Middle 

Bottom Right 

Pattern 

Boundary 

     Stay Reference Point 

If you want to stay on reference point after job finished, you can choose this 

option. This option can save your time when you want to use. 
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3.4.4  Power Scale 
 The Power Scale tab is divided into two sections, Power Scale and Custom Power 

Scale. 

 

1. Power Scale 
The Power Scale section is used to adjust the strength of the laser power. 

While in Rubber mode, the Power Scale function will control the curve of the 

tapered profile. While in Gray (3D) mode, with 16 Levels option selected, the 

Power Scale function will control the amount of laser power for each gray level. 

The horizontal scrollbar is used to adjust the default power scale setting. The 

vertical scrollbar and the input boxes below the bar graph are used to 

independently adjust each power scale depending on which scale is selected. 

2. Custom Power Scale 
The Custom Power Scale section allows the user to Save and Load up to five 

Power Scale parameters for later use. 
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3.5  LTT Product Tools 
3.5.1  System Upgrade 
 Generally, the file for upgrade will be provided from LTT. The file type is [*.ice]. 

While upgrade is processing and the power is turned off or the cable is disconnected, 

the SLC-M may not be upgraded for the moment. If this situation happens, please 

contact LTT. 

1.  Turn off the SLC-M, and check that the SLC-M is connected with PC through USB 

cable. 

2.  Turn on the SLC-M and computer. Press and hold     on the control panel right 

after turning on SLC-M until the following screen appears. 

 

3.  Run [LTT Product Tools], and select the printer. 

 

ILS-IIIa 
firmware  upgrade 

V 3.01 
READY !!! 
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4.  Then select the [*.ice] file with […] key, then press [Send] key to upgrade the 

firmware of SLC-M. 

 

5.  You will hear two short beeps along with the following display, showing that the 

upgrade has completed successfully. 

 

6.  Press     on the Control Panel and you will hear a beep after which SLC-M 

returns to main menu. 

7.  Check the firmware version in the 4th line of the [ABOUT] submenu (See section 

3.3.2). 

 

 
firmware  upgrade 

complete  ! 
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3.5.2  Ethernet Settings Upgrade 
 1.  Please repest the steps (1)~(4) in section 3.5.1. 

2.  The computer name will be obtained automatically, and make sure that it is 

composed of English character and number. If you want to modify for another 

computer, you can change the computer name manually 

 

3.  Then select the shared folder by the […] key, make sure that the folder has been 

set to shared. Press [Update] key to change Ethernet settings. 
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5.  You will hear two short beeps along with the following display, showing that the 

upgrade has completed successfully. 

 

6.  Press     on the Control Panel and you will hear a beep after which SLC-M 

returns to main menu. 

7.  Check the Ethernet setting which is shown in the submenu of [FILE MANAGER] 

on control panel. (See section 3.3.2). 

 

3.6  Basic Operation Flow with CCD 
 This section explains the basic and common steps to operate SLC-M with CCD. If you 

want to obtain more detail about operation, please see section 3.7 and 3.8. 

Before executing the steps in this section, please make sure that you have already 

finished all steps in chapter 2. 

1. Get machine ready. 
 Turn on the power. 

 Wait for system start and homing process finishing. 

2. Get PC ready 
 Check the connection between PC and machine 

 Turn on the PC 

 Execute AutoCCD.exe 

3. Adjust focal height (if necessary) 
 Put the material on the table. 

 Move the carriage above the material. 

 Press     and select [Yes]. 

4. Adjust working distance (if necessary) 
 Move the CCD to see any pattern 

 Adjust the working distance when image in CCD monitor is clear. 

 Setting CCD shift 

 Setting units transform 

5. Setting drawing parameter in AutoCCD  

 Load drawing file 

 Setup Mark distance 

 Setup two point setting 

 Setup start point 

6. Start AutoCCD procedure 

 
firmware  upgrade 

complete  ! 
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 Select printer 

 Click       to start CCD task 

 

3.7  AutoCCD 
 AutoCCD is the main control program for cutting with CCD. It is to find reference 

marks of work piece, and moving and rotating the drawing to the new locate of work 

piece. 

This section explains functions of AutoCCD and how to use them. 

  

3.7.1 Controls 
 

 

 

1. Address: The CCD IP address. You need to enter the password in [CCD and 

Control Setting] to change it.(See section 3.7.1.1 for more detail) 

2. User & Password: User name and password for CCD control account. You need to 

enter the password in [CCD and Control Setting] to change it. 

3. Show Sheet: Show the sheet form in CCD monitor. (This function is only for 

pattern training and key-in the unit transformation parameter temporality. 

Do not change any other parameter.) 

4. Show Image: Show the CCD Image in CCD monitor. 

5. Online: Make the CCD function working. You can see the real time result of pattern 

position and image in CCD. 

6. Live: See the real time image from CCD. 

7. Zoom in: Zoom in the CCD image in CCD monitor. 

8. Zoom out: Zoom out the CCD image in CCD monitor. 

9. Connect: Connect to the CCD device. Before connect, please check the setting of 

CCD IP address and user account.  

10. Zoom to fit: Zoom in/out the image to fit the vision zone of the CCD Monitor. 
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3.7.1.1 Find the CCD IP address 
 1. When connecting to CCD, it will use DHCP to get an IP address. When CCD 

connection is all right, In-sight will show the device in [In-Sight Network]. You can 

press [Ctrl]+[Shift]+[1] to show [In-Sight Network] window 

 

 

2. When CCD device is connected. Chick [Help]->[About In-Sight Explorer] to 

see the IP address of CCD device. 
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3.7.2 AutoCCD Monitor 
 

 

This area can show the image from CCD on time or last time. If the [Show Sheet] 

is selected, it can show the location of reference mark or temporary retrain the 

pattern.  



Chapter 3   Operation 

 83 

 

3.7.3 Task Control 
 

 

 

1. File location: load the drawing file. (See 3.7.3.1 for more detail) 

2. Printer: Select the working machine. 

3. Mark Distance: The distance between reference mark and working picture. (See 

3.7.3.2 for more detail) 

4. Two Point Setting: The distance between two reference marks.(See 3.7.3.3 for 

more detail) 

5. Start Point: The position to search the first reference mark. You can use functions 

of [Position Test] to find it. 

6. Task Count: Count the work-piece and limit the total work-pieces. (The counter 

only count a successful job) 

7. Start: Start the procedure of CCD function and working. 

8. Parameter Lock: Lock parameters in AutoCCD to prevent un-carefully parameter 

change during working. 

 

3.7.3.1 Drawing File 
 Drawing file is only contained drawing for cutting. Any other reference drawing will 

make wrong cutting position. Drawing file should be the format in plt or prn. When 

print, please select [Print to file] 

 

3.7.3.2 Mark Distance 
 Mark Distance means the distance between reference mark and the top left of the 

drawing. If the top left of the drawing is a curve, the distance is showed below. The 

values of dX and dY are minus in below drawing. 
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For example, the values of dX and dY in below drawing are -6 and -6 

 

 

3.7.3.3 Two Point Setting 
 Two Point Setting is the distance between two reference marks. If the top left one is 

the origin of the coordinates, the coordinate of the bottom right one is the setting. 
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For example, two point setting of above picture is dX= 6 , dY= 4 

 

3.7.4 CCD Setting Control 
 

 

1. CCD shift: The CCD-shaft is the distance between laser focus and the center of CCD 

camera. (See 3.7.4.1 for more detail) 

2. CCD Field of View: This function is not used. 

3. CCD and Control Setting: Before change the CCD IP address, CCD account and CCD 

shaft, you need to enter the password. When enter the 

password, you need to click [OK] to make it work. After 

change those settings, you can click [Disable] to disable 

any other one from changing settings. 

4. Position Test: You can move the carriage by using this function. You can find the start 

position by using this function too. (See 3.7.4.2 for more detail) 
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3.7.4.1 CCD shift 
 Before measure the CCD shift, please prepare a black paper. 

1. Put the black paper on the honeycomb table. 

2. Drawing a cross mark. The center of the mark is on (200,200).(Please use 

CoreDRAW to output the drawing, AutoCAD may cause the calculation of CCD shift is 

wrong) 

3. Move the carriage by using function of [Position Test] to see the cross mark. You 

can train the cross pattern. Then, check the CCD pixel coordinate of the cross mark is 

close to Row=240, Col=320 

4. See the [Current Position] for the coordinate of the carriage position. 

5. Using (200,200) to minus the coordinate in ○4 . You can get the CCD shift. 

CCD shift 計算示意圖 

CCD shift X= , Y= 

 

3.7.4.2 Position Test 
 This function is to use for finding star position and moving carriage. 

 

1.Go To: Set up the position to move 

2. Current Position: Show the present coordinate of the carriage. 

3. Go To Position: Move the carriage to the position which is setting in ○1  

4. Go To Position 2: Move the carriage to the position 2 which calculates from ○1  and two 

point setting. 

5. Homing: Move the carriage to home and reset the position of home if the carriage loses 

its position. 

6. Set as Start Point: After finding the start position, you can set the coordinate in ○1  to be 

the start point by click this button. 

7. Moving Distance: You can set up the distance for moving carriage. 

8. Moving Left: Move the carriage to left. The distance is setting in ○7  
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9. Moving Top: Move the carriage to Top. The distance is setting in ○7  

10. Moving Right: Move the carriage to right. The distance is setting in ○7  

11. Moving bottom: Move the carriage to bottom. The distance is setting in ○7  

 

3.7.5 Communication Setting 
 Communication Setting is setup the communication port of RS232. Before change 

this setting, you need enter the password and click [OK] to allow  changing. Please 

only change the port. If change other settings, the connection between PC and 

machine may not be made. The [Disable] button can disable other one without 

permission to change the setting. 

 

3.7.6 Tips of AutoCCD 
 The AutoCCD has a hot key function. When all parameters are setting. When the tap 

is on [CCD Task Control], you can press [Enter] to start the CCD task. When 

quantity production. You can connect a mini number keyboard. Setup parameters 

first. Then, you can just load/unload work-pieces and press [Enter]. 

Other Hot Keys 

Controls:  

Connect = Alt + C 

CCD Task Control: 

Browse = Alt + B 

Run = Enter 

CCD Setting: 

Go To Position = Alt + G 

Go To Position 2 = Alt + 2 

Homing = Alt + H 

Set as Start Point = Alt + S 

Up = Alt + U 

Down = Alt + D 

Left = Alt + L 

Right = Alt + R 

Ok = Alt + O 

Communication Setting: 

Ok = Alt + O 

 

3.8  In-sight Explorer 
 In-sign explorer is the CCD control software. It is used to setup the job which finds 

the coordinate of reference mark from the image saw by CCD.  
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3.8.1 Load a job 
 1. Click the [In-Sight Explorer 4.1.1] icon to execute In-sight Explorer. 

 

2. Click the CCD device in [In-Sight Sensors]. (You can click Shift + Ctrl + 1  to 

show this window) 

 
 

 

3. Click [File] -> [Open Job] to load job 

 

4. Load the job [LTT-01.job] which is included in Install CD. (Please use this job to 

modify to a new job) 
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3.8.2 Pattern Training 
 Pattern Training is to locate the reference mark. When train the pattern, please make 

sure there is no any back ground to influence the training. 

1. Using online mode or live mode to find a reference mark. 

 

 

 

2. Double click [Patterns] to train pattern 

 

 
3.You can see the findpatterns window. Double click [Model Region] to define the 

reference mark. 
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4. Use the red frame to bound the reference mark. Double click to complete. 

 

5. Double click [Model Settings] to define the center of the reference mark. 

 

5. Use the red cross to locate the center of the reference mark. Double click to 

complete. (Please use zoom in fuction to locate center) 
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7. Click [OK] putton to complete. 

 

8. You can see the resoult by click [Patterns] to move the frame on it. To close the 

sheet can see it more clear. 
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3.8.3 Units Transform 
 In this section, we will teach you how to calculate the units transform between pixel 

and mm. This parameter will vary with working distance.  

1. Please put the work-piece on the honeycomb table  

2. Move the carriage to see the frame of the work-piece. 

 

3. Train the pattern on the piece. 

4. Cover one of them, You can get a CCD pixle coordinate of the other. 

 

5. Cover the other one, You can get a CCD pixle coordinate of first one. 

 

6. Using values from step 4 & 5 to calculate the distance between two patterns in 

pixels 

   22 2121 RowRowColColdistancepixel   
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7. Use the value of two pattern real distance to divide by the value of units transform. 

distancepixel
distancemeasuretransformUnit   

8. Key-in the value from step 7 to the D5 in the sheet of the job 

 

 

3.8.4 Save as a New Job 
 After modify the job, we suggest you to save the modified job as a new job. The 

original job to be a back-up file 

1. Click [File] -> [Save Job As…] 

 

2. Click [In-Sight Devices] and select the CCD device 
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3. Key-in the file name you want in the file name diagram and click [Save] 

 

 

3.8.5 Set the Default Job 
 When AutoCCD connects to the CCD, it will use the present job in In-sight explorer. 

If In-Sight Explorer does not be executed, AutoCCD will load the default job. 

This section will explain how to setup a job to be the default job. 

1. Connect to the CCD. 

3. Please make sure the job you want to set as a default job is in the CCD device. You 

can check it from the [In-Sight Files]. You can see display or hide it by pressing 

Shift + Ctrl + 2. 

3. Click [Sensor] -> [Startup…] 
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4. Select the job you want to be set as the default job. Then, press [OK]. The setting 

will take effect after CCD restarted. 
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Chapter 4  Maintenance 

4.1  Daily Cleaning 

 

1. Preparation 
 Ensure that the system is turned off and the AC power cable is 

unplugged. 

 Prepare for cotton swab, cotton cloth, and alcohol. 

2. Clean machine 
 Remove all loose dirt and debris from inside of the machine. 

 Clean the top window with cotton cloth and alcohol. 

 Clean all of the rails of the motion system with cotton cloth and 

alcohol. 

3. Clean lens and mirror 
 Clean the window lens with cotton swab and alcohol. 

 

 Clean 4th mirror with cotton swab and alcohol. 
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 Clean 5th mirror and focal lens with cotton swab and alcohol. 

Clean 5th  mirror with cotton swab and alcohol 

 

Loosen these two screws by hand, and take off the cover. 
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Pull out the focal lens, clean it (both sides of lens), and push it back. 
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Assemble the cover and screws back. 

 
 Clean CCD lens cover with cotton swab and alcohol. 

Loosen these two screws, and take off the LED light. 
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Clean CCD lens cover with cotton swab and alcohol 

 

Assemble the LED, and screws back 
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4.2  Weekly Cleaning 

 

1. Preparation 
 Ensure that the system is turned off and the AC power cable is 

unplugged. 

 Prepare for compressive air which is waterless and oil free, dry 

brush, cotton swab and alcohol. 

2. Clean machine 
 Clean all electric components with compressive air and dry brush. 

 Clean exhaust port with brush. 

 Clean all cooling fans with compressive air. 

 Clean all filter cottons. 

3. Clean lens and mirror 
 Clean 3rd mirror with cotton swab and alcohol. 

Loosen the two screws by hand, and take off the cover. 
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Clean the mirror. 

 

Assemble the cover and screws back. 
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Chapter 5  Trouble Shooting 
 This chapter provides suggestions to check and solve some common problem. If you 

can’t find any answer in this chapter, please see introduction to call technical 

support!! 

Problem Cause Remedy and reference 

Power is not turned 

on. 

AC power cable is not connected 

properly. 

Check Hardware Installation. 

(See section 2.4.) 

Emergency stop is pressed 

down. 

Turn right the pushbutton. 

(See section 2.3.) 

Laser beam is not 

emitted. 

Laser on/off switch may be 

turned off. 

Turn on the switch. 

(See section 2.3.) 

Doors with interlocks are not 

closed. (If “Door” indicator is 

dark.) 

Close all doors with interlocks. 

(See section 2.3.) 

The temperature of laser 

generator is too high. 

Stop job for a certain time to 

cool laser generator. 

Laser beam is misalignment. Realign by adjusting mirrors. 

The setting of laser power is too 

low. 

Increase the setting. 

(See section 3.4.2.) 

Laser generator has 

breakdown. 

Please contact LTT. 

(See Introduction) 

Cutting or engraving 

quality is bad. 

Focal length is not suitable. Adjust focal length. 

(See section 3.3.1) 

Lens and mirrors are dirty. Clean the lens and mirrors. 

(See section 4.1 and 4.2) 

Setting of focal length on panel 

does not match with lens. 

Modify the setting. 

(See section 3.3.2) 

Lens and mirrors are broken. Please contact LTT. 

(See Introduction) 

The settings of laser power are 

not suitable. 

Modify the setting. 

(See section 3.4) 
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Appendices 

Appendix 1  Specifications 

 This section describes the specification of the SLC-M series. 

Model SLC-M 

Work area 600 (L) × 500 (W) mm 

Focal lens 

Movement 

50 (H) mm 

Max. speed 300 mm/sec (11.8"/sec) 

Resolution(DPI) 1000, 500, 333, 250, 200, 160 

Memory Buffer 64MB 

Interface USB port 

Laser generator 30W /60W /100W 

(air-cooled CO2 laser) 

Power supply 220~240V AC, 15 Amp, 50/60 Hz 

Exhaust requiring at least 6.0 m³/min air flow for two 4" connection 

Regulatory 

Compliance 

RoHS directive 

Standard Auto Focusing 

Red-beam Pointer 

  Beam Expender 

Honeycomb cutting table 

Options Blower 

Air compressor 
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Appendix 2  Dimensions 

 This section describes the dimensions of SLC-M series. 

 SLC-M series 
Unit:mm 
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Appendix 3  Suggested Power and Speed Settings 

 The below settings are only intended to be starting points. Many variables can affect 

actual settings. Different manufacturers have different formulations, laser tubes 

differ in actual power output, natural materials vary greatly, and the user desired 

results will drastically affect actual settings. 

Laser Source : 30 Watt 
Material Type Thickness Speed Power PPI DPI 

Acrylic Engraving  100% 20%  500/1000 

Cutting 3 mm 3% 100% 1000  

5 mm 2% 100% 1000  

10 mm 0.5% 100% 1000  

Anodized 

Aluminum 

Engraving  100% 40%  500/1000 

Card Stock Cutting  40% 100% 250  

Cermark Engraving  25% 100%  500 

Ceramic Tile Engraving  60% 100%  500 

Coated Brass Engraving  100% 50%  1000 

Crystal Engraving  100% 30%  500 

Denim Engraving  100% 30%  500 

Cutting  20% 100% 500  

Glass Engraving  100% 50%  500 

Granite Engraving  60% 40%  333 

Laser Foil Cutting  50% 100%  1000 

Laserable Plastic Engraving  100% 20%  1000 

Cutting 1.5 mm 8% 100% 500  

Leather Engraving  100% 70%  500 

Cutting  2% 100%   

Marble Engraving  60% 23%  333 

Rubber Stamp Engraving  15% 100%  1000 

Cutting  4% 100% 500  

Wood Engraving  100% 100%  500/1000 

Cutting 3 mm 7% 100% 500  

6 mm 2.5% 100% 500  

 
 
 


